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In this class you will learn to:

« Use bullets and numbering
 Insert headers and footers
 Insert page numbers

- Add a page border
 Insert pictures and Clip Art
« Resize pictures

« Create columns

« Create page breaks
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Create bullets or numbers for

an existing list.

* To convert existing text to a
simple bulleted list, select the
text.

* Then, click either the bullet or
the number icon on the
Paragraph group of the Home
tab to apply that type of list.

* You can also click the drop-
down arrow next to either icon
to choose a different format.
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Create bullets or numbers for

a list as you type.

* To create a list while you type,
click the Bullets or Numbering
command.

* Type the information for the first
bullet or number and then press
Enter to move to the next level.

* Once you have completed
entering the items in your list,
press Enter. A new
bullet/number will be created.

* Press Enter and then the
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This is a point. When | press Enter, the curser will move to the next point.
This is a second point.
This is the third point and the end of the list.
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*  Thisis a point. When | press enter, the cursor will move to the next point.
- * Thisis a second point.

* This is the third point and the end of the list.

Backspace key three times to
signify the end of the list and
remove the indentation.
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HEADERS AND FOOTERS

Document4 - Word
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Insert a header or a footer. "L =
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* Go to the Insert Tab, then click Header : Casiuidbiiineiisi
or Footer. . " - e

* Click the type of header or footer that : ety
you want to add and it will - e
automatically be inserted into the :

= Banded
document. :

* You can format header/footer text just :

. . ~ Facet (Even Page)
like you would any other text contained : = =
in your document. . ?

':‘ Facet (Odd Page)

* Double-click at the top or bottom of the : -w
page to see header and footer tools = [
where you’ll discover more options for g T T o S T2 More Headers from Office.com L

. [ Edit Header
formatting your headers and footers. e Rermove Hosde
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HEADERS AND FOOTERS

Change the distance
between the physical end of
the page and your header or
footer

Navigate from header to header in

Change header or footer styles the document

H -0 @, = O = Header & Footer Tools Document4 - Word

File Home Insert Design Layout References Mailings Review View Q Tell me what you want to do...

D D @ r‘ ﬁ Q I__l [Z14 Previous Different First Page _,*Headerfrom Top:  0.5" : B
O =b O s : - S
= = [Eip Next Different Odd & Even Pages + Footer from Bottom: 0.5 .

Header Footer Page Date & Document Quick Pictures Online Goto Goto Close Header

= = Number~ | Time Infor Parts~ Pictures | Header Footer ».: Link to Previous V| Show Document Text Insert Alignment Tab and Footer
Header & Footer Insert Navigation Options Position Close
Insert document info
Close Header & Footer tools tab
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HS-

File

Add a page number.

* Go to the Insert Tab, then click
the Page Number command in _
the Header & Footer group. — |-

* Hover over the different :
placement options. This will open -
an expanded menu.

* Click on an option in the ;
expanded menu to insert the .
page number in that location and :
format.

HEADERS AND FOOTERS

Page 1 of 1

g = 0O -

Home Design Layout References Mailings

s 1) TE SmartArt
JEE Rl O=
0 leg & L0 e &
Pages  Table Pictures Online Shapes Add- | Online
- - Pictures - &4 Screenshot ~ ins*  Video -
Tables INustrations :

[Type here]

Owords [j2 23

e e e 3

Document4 - Word

Review

)

Links  Comment

Comments

View @ Tellme..
™ Header~
D Footer -

Text
[#] Page Mumber ~ Box =
[F] Top of Page
[E Bottom of Page

B

[/] Current Position

Page Margins

Erg Format Page Mumbers...

E;( Bemove Page Numbers

*

3

3

3

Desimone, Elizabeth gr Share
- |}‘ - Q
LB
i Symbals
M- -

Simple
Plain Number 1

1
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CREATE A PAGE BORDER

Document4 - Word &= = O X

Layout References Mailings i Desimone, Elizabeth Q_ Share

* Go to the Design menu tab. Click
the Page Border button located in—"
the Page Background group.

=# Paragraph Spacing

'::'_' — Colors Fonts
d + @ Setas Default

Document Formatting A
L 1"‘&‘-‘5"-l‘>-l-"l"-2--A|4>~3-‘-|‘>l4-1-|‘»-5--‘|>‘-6'-‘é‘-~'7"'
* The Borders and Shading dialog box |..
will open. Select a setting from the |- =]
menu on the left-hand side. e Borders  Page Border | Shading

‘) Setting: Style: Preview

Click on diagram below or
use buttons to apply borders

* Use the options in the middle to : |
choose a style, color, width, and/or :

art. . ’ —
* Finally, use the options on the right |- 2 [T
to choose what edges will have a : ] e | 2 )
N i il I < ,
bo rd er. Art: _‘ Avp\..’itoflteot;locumen! -ﬂ
- R il | Options...
* The “Apply to” box lets you apply -
. %| ok || canc
these changes to the whole ’ I
document, a section, or a portion of ==
d Sectlon. Page1of1 Owords [ 83 [E 5] B - 1 + 100%
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INSERTING OBJECTS

H ©-0 E( = 0O - Document] - Word = = O
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| Rectangles
* Click on Shapes in the lllustrations : OODNADNOO0
Basic Shapes
group. : B0 ANING00666
| SOt o
. . . A ) B3
* A dropdown menu will appear. Single- |- O000
1 N Block Arrows Lightning Bolt
click on the shape you want. : 2%““””5%
. . . - Wiy ey O 2 [l 6]
* Either single-click on the document : BEa
working area to insert the shape ina | s
. - Flowchart
default size.... . e L ee oy
. . : ocvudr®@s X ¢ AVAD
* ..or,click and drag on the working " Q=00
. . R Stars and Banners
area to insert the shape with a : B ADOO @B BEN
customized size. : . A=l
N A0SO aOM A A g A A
g A0AD O
7 E‘j Mew Drawing Canvas
:agenm owords [ 83 B B - 1 + 1008
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THE DRAWING TOOLS TAB

The Drawings Tools tab appears when you insert a shape. If you click off of your shape, the Drawing Tools
tab will disappear. Simply click the shape to make the tab appear again.

Insert shape Customize WordArt

Apply custom formatting Change size of shape

BH ©- Ei = 0 - Drawing T Document1 - Word
File Home Insert Design Layout References Mailings Review View Format N Q Tell me what you want to do... Desimone, Elizabeth g, Share
[AE N N OO | £ Edit Shape - ~ L2 ShapefFill - A Text Fill A * = 4 ¢ Align - £ Heigh 8
~ b # [ Height: |2.66
O AL L L+ [ Draw Text Box u a ﬂ D a ﬂ - ’-2 Shape Outline - A A Text Outline~ | ¥¥¥¥¥ [*] B [j ‘_] D . [‘\ tE1 Group
G ~ - - Text Align Create Position Wrap  Bring Send  Selection Swidth: |2.19"
R R TASE N &2 Shape Effects - A Text Effects™ | Direction - Text~  Link - Text~ Forward~ Backward~ Pane - hFRotater | €
Insert Shapes Shape Styles 1] WordArt Styles Text Arrange Size (F] ~
Apply preset formatting Insert WordArt Arrange shapes on page or in relation to each
other
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INSERTING OBIJECTS

E (&) @ ™ D = Document2 - Word

INSERTING PICTURES FROM File Design Layout References Mailings Review View Q Tell me what you want to do...
AFILEON YOUR COMPUTER: & 1 [ [ ()T goe W [0 & F ] [ @D~ | 1 cuon -

V4

. : 1l Chart o ) : [2) Footer~ 4 - B3 € Symbol -
Pages Table (Pictures Online Shapes ‘M Add-ins ~ Wikipedia Online Links  Comment Text
- Pictures =~ @4 Screenshot~ SEY. Video - [ Page Number~ Box~ £~
. Tables Ilustrations Add-ins Media Comments Header & Footer Text Symbols ~
Go to Insert tab > Pictures. - O — —— — ———— —_— - - 0
. [F] Insert Pict ‘E‘
. . . ° 4 [& > ThisPC » Pictures v O Search Pictures pe)
A dialog box will open. Click a : -
= Organize ¥ New folder =~ [ @
single file or hold Ctrl and = Oneor ~
neDrive
click multiple files. = ThispC m ﬂ %
R 2 D t = -
&l Documents filter 2 filter Fountain

Click Insert when you’re : ¥ Downloads
D Music
ready.

= Pictures

\

i Local Disk (C >
& Local Disk (C) Gargoyles library skyscrape success kid Tilting Building
20FD (E:)

The picture will then be
added to your document. The = e,
Picture Tools — Format tab will : = GROUPDIR (\EB

. - = USB20FD (E)
also become available. : v
File name: \ v‘ All Pictures v
. Tools Insert  |w Cancel
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INSERTING CLIP ART:

* Go to Insert = Online

INSERTING OBIJECTS

Document2 - Word

Layout References Mailings Review View Q Tell me what you want to do...

Desimone, Elizabeth £, Share

B D B D@ \;:' T SmartArt 8 store W E% e, t,j [ Header~

Pictures.

¢ Adialog box will appear.
Type what you’re looking

D’,' ~ TU Equation ~
-

A=| E -
1 I Chart . [2) Footer~ 4 - iy €2 Symbol -
Pages Table Pictures Online Shapes ‘MyAdd-ins . Wikipedia Online Links Comment Text J
- = N Pictures =~ &+ Screenshot ~ be Video - [#) Page Number ~ Bax~ M-
7
Tables Illustrations Add-ins Media Comments Header & Footer Text Symbols A
L L0 L a2 a3 A B s e 6 e AT

Insert Pictures

for in the search box.

* Hit Enter.
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INSERTING CLIP ART:

(cont.) You will then see
images appear in the dialog
box.

Click the image you want to
select it, then click Insert at

the bottom of the dialog box.

The image will be inserted
into your document at the
location of your cursor.
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TO RESIZE A PICTURE, CLICK
AND DRAG THE HANDLES.

As you drag the handles, you
will see the photo become
larger or smaller, depending
on the direction that you
drag in.

Handles on the sides resize in

INSERTING OBIJECTS

Document1 - Word

Design Layout References Mailings
EQ Corrections~ [, - (- —— L# Picture Border -
‘ & Color~ B ||t | aml || e |- | O] Picture Effects~
Remove - -
Background (23 Antistic Effects~ 43 ~ ~| B Picture Layout ~
Adjust Picture Styles
L R R PR

-

one direction.

Handles in the corners resize
in two directions.

You can also enter exact

dimensions in the Size group
of the Picture Tools — Format
Tab.
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Text - Dk Selection Pane
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THERE ARE TWO WAYS TO

ROTATE A PICTURE:

* Select a picture and use
the Rotate options on the
Picture Tools — Format tab

or the mini toolbar.

* Or, click and drag the
white arrow.
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THE PICTURE TOOLS TAB

The Picture Tools tab appears when you insert a picture into a document. If you click off of your picture, the
Picture Tools tab will disappear. Simply click the picture to make the tab appear again.

Make your picture brighter or duller, Apply border effects to

Position your pictures on the
sharper or softer, warmer or cooler your picture

page or in relation to each other

H - G = 0O -

Document1 - Word Picture Too [E3] = O X
File Home Insert Design Layout References Mailings Q Tell me what you want to do... Desimone, Elizabeth ,O+ Share
EE Corrections~  [=|. Compress Pictures J— g e LZ Picture Border - |E| Bring Forward |: - £ -
—— [« Color ~ %) Change Picture | il |l il ol el ~ | @ Picture Effects - = Send Backward ~ £l L
Remove —_— — R — - Position Wrap _ . Crop =2 5 g4v -
Background [Z3] Artistic Effects ~ “0.] Reset Picture ~ - [::la Picture Layout ~ < Text~ Dl Selection Pane A~ - ©F" -
f Adjust Picture Styles f 1l Arrange Size * oA
Apply formatting effects such as pencil Customize border effects Set the size of your pictures

sketch, film grain, paint brush, etc.
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PAGE BREAKS

E -0 |£ri =] D = Document] - Word
File Home Insert Design References Mailings Review View Q Tell me... Desimaone, Elizabeth ,q_ Share
USI NG PAG E BREAKS rh[lrientation' 1= Breaks Indent Spacing Ering Forward [& Align~
- IE Size v Page Breaks x Auto s . Send Backward Group
Margins == col At —1| Position Wrap ’:QS T ——
. . - == Lolumns~ qu uto - Text [m] €lection Fane wolate
° A page break ISa phySI(:al end to Page Setup ’|_| Mark the point at which one page ends It Arrange ~
and the next page begins.
the text on a page. LI E— B N A
) [~ Column
Indicate that the text following the column : e I
. break will begin in the next colurmn. d Alice to herself, r«jn.her sharply: ‘T advise you to
N PI h t . 1 self very good advice, (though she very seldom
dace yOU r Cursor wnere y0u wan - f Text Wrapping f so severely as to bring tears into her eyes; and
. . c Separate text around objects on web s for having cheated herself in a game of croquet
to place the break. Then click ; d pages, such 35 caption textfrom body tex. 1414 was very fond of pretending to be two people.
Layout tabe Breaks 9 Page - ° Section Breaks tend to be two people! Why. there’s hardly enough
: i C
- Next Page
7 4 Insert a section break and start the new lying under the table: she opened it, and found in
. i |==] section on the next page. ME" were beautifully marked in currants. “Well,
* To remove a page break, place “ I = Continuous eger, [ can reach the key: and if it makes me grow
. . i 5 Insert a section break and start the new ay I'll get into the garden, and I don’t care which
your cursor at the beginning of the E section on the same page.
- =1f, “Which way? Which way?’", holding her hand
page after th e page b rea k an d E C |Z2=| EvenPage ) _ growing, and she was quite surprised to find that
R — Insert a section break and start the new X
= 1 - erally happens when one eats cake, but Alice had
B k m section on the next even-numbered page. l i
p ress backs pa ce. E £ ut out-of-the-way things to happen, that 1t seemed
) C 1 Odd Page mon way.
| - Insert a section break and start the new L
If h h f . - = section on the next odd-numbered page. “the cake.
* |If you have paragraph formatting :
shown, a page break looks like : CHAPTER II. The Pool of Tears
th IS: - ‘Curiouser and curiouser!” cried Alice (she was so much surprised, that for the moment she quite
. forgot how to speak good English); “now I'm opening out like the largest telescope that ever was!
- Good-bye, feet!” (for when she looked down at her feet, they seemed to be almost out of sight,
. they were getting so far off). “Oh, my poor little feet, I wonder who will put on vour shoes and
................................... Page Break S— = - b A Tt T e =i = - P
gelof1 S69words [J2 83 B B - 1 +  100%
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COLUMNS

TO DIVIDE TEXT INTO COLUMNS, CLICK
THE LAYOUT TAB

* Select the text that you want to format.
* Click the Columns button.

* For more variations, click More Columns
at the bottom of the Columns command
to open the Columns dialog box.

Columns rI”E‘

Presets

One Three Left Right
Number of columns: 3 =3 El Line between
Width and spacing Preview
Col# Width: Spacing:
[ ] 183 3 o5 +
183" ¢ [os $

183"

@ Equal column width

Start new column

coce

Applyto: Whole document V|

H® 0R

= O -

Document] - Word

rie v eI e 4f Layout

@ rrj Orientation =

[ Size -
Margins

255 Columns ~

7 Two
; Three
: Left
:\ Right

Page 1 of 5 2382 words

== More Columns...

’# Breaks - Indent
fline Numbers - 3= Left: 0"
bT Hyphenation~ =& Right: 0"
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+

a January evening
early seventies,
= Nilsson was
in Faust at the
y of Music in New
York.

Though there was
already talk of the erection,
in  remote metropolitan
distances "above  the
Forties." of a new Opera
House which  should
compete in costliness and
splendour with those of the
great Buropean capitals, the
world of fashion was still
content to reassemble every
winter in the shabby red
and gold boxes of the
sociable old Academy.
Conservatives chenished 1t
for be.i.mz small and

=

References

|

Mailings Review
Spacing

. I: Before: |Auto

:*:After: Auto

Paragraph ]
[ ST ST BECIC R

broughams, in the spacioul
family landau, or in th
humbler but mor
convenient "Brown coupe.
To come to the Opera in
Brown coupe was almost a
honourable a wav o
arrving as in ome's ow
carriage; and departure b
the same means had thi
immense advantage o
enabling one (with

playful allusion t
democratic principles) t
scramble into the firs
Brown convevance in thi
line, instead of waiting ti
the cold-and-gin congeste
nose of one's ow
coachman gleamed unde
the portico of the Academy
It was one of the grea
liverv-stableman's mos
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EXERCISE

Add a page border.
- Click Design - Page Borders.
- Click Art.
- Scroll through until you find an image you like.
- Click OK.

Insert WordArt.
- Hit Enter a few times to create a space for your WordArt.
- Click Insert > WordArt.
- Choose a style you like.
- Type “Birthday Party!” Click and drag the text box into the space you made.
- Go to the Picture Tools format tab; click Align = Align Center.

Make a bulleted list.
- Click beneath your WordArt. Hit Enter a few times.
- Click the bullet button.
- Make a list of everything you’ll do for your birthday, at least six things.
-At the end of your list, hit Enter twice to move to the next line.

Make the list into columns.
- Highlight your list. Make sure you don’t have anything extra highlighted.
- Click Layout = Columns = Two.
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EXERCISE

Insert a picture.
- Click the Insert tab.
- Click Online Pictures.
- Search for birthday.
- Double click the picture of your choice.

* Resize the picture.
- Go to the Height box in the Picture Tools format tab.
- Click in the box and type 3.5. Press Enter.

* Use the Position button in the Picture Tools format tab to place the picture in the lower right
corner.

* Apply an Artistic Effect.
- Click Artistic Effects in the Picture Tools format tab.
- Hover over the thumbnails to see the different effects.
- Click on the effect of your choice to apply it.

Add a shadow.
- Click the Picture Effects button in the Picture Styles group.
- Click Shadow.
- Choose any of the shadows in the Perspective group at the bottom of the menu.
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EXERCISE

* Insert a smiley face.

Click the Insert tab.

Click Shapes.

Click the smiley face in the third row of the “Basic Shapes” group.

Click and drag on the document to create a smiley face about the size of a lemon.

* Change the shape’s color.

Click the dropdown arrow in the Shape Styles gallery.
Choose a new color.

* FOR MORE INFORMATION OR EXERCISES, TRY THESE SOURCES:
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Lynda.com—Cert Prep: Word 2010 Microsoft Office Specialist

http://spclc.org/sites/default/files/Word Exercise 10 - Bullets and ClipArt.pdf




COMMON KEYBOARD SHORTCUTS

CTRL+A Select entire document/page
CTRL+C Copy selected text/object
CTRL + X Cut selected text/object
CTRL+V Paste selected text/object
CTRL+Z Undo your last action
CTRL+F Find specific text in the current document
CTRL+S Save the current document
CTRL+P Print the current document
CTRL+B Bolds the selected text

CTRL +1 Italicizes the selected text
CTRL+ U Underlines the selected text
CTRL+N Create a new document
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ADDITIONAL RESOURCES

Additional helpful resources can be accessed through our homepage www.jplibrary.net

* From the JPL homepage, click on the Digital Content Tutorials * After the course menu opens, click Full Screen
(blue rectangle) next scroll bar. at the top of the course menu to view tutorials.

«” Full Screen % Close

& Jefferson
. Select Langu v
w = Jm Parish l’j volWw [find books, DvDs, and more... |l Seanch | T

Library JPL Digital Content Tutorials 2

Home | Locations < | Services v‘ Reference = | Policies — | Library Info = | ILL ‘ Catalo Digital Content | Databases | Childrens/Teens/Adults <> | Calendars | Contact Us <

D Find Books, DVDs
A CDs, and more in the @ Online Databases
Catalog Search NOTICE: Repairs require tempora, ¢
Bl Gisa entrance at East Bank Regional a Ask a ibrarian (- 1 **Click and Learn JPL Digital Content Apps >
- Users of East Bank Regional Library » e
Jﬁl. Log.in to your must enter through the administration +4‘3—WL |
account

entrance on the right side of the library.

Computer Classes Adult | eaming

(Brainfuse) s of East Bank Regiona ! **|PL's Basic Computer Skills Learning Guide >

@ Your Library Click fiere formore information Besources (Brainfuse) on the right side of *Homework Louisiana (Tutor.com) Tutorial - Real
f ‘ Free Online Tutoring . s >
\ Text-a-Librarian Q) for K-12 and College ; experts, waiting to help you now
| S ) -k here for more inforr

] Get email reminders
ﬁO_Liuﬁ_i‘aEE

Search the collection
Research Library

. In‘ter-ne't -
, *Internet Basics >

*Joining Cisco Webex Meetings >

Information for all
Jefferson Parish Libraries

1
Belcume a Teen
~ | Volunteer « The Jefferson Parish Library is open to the public, but hours (Pronunciator) H
*
may vary by branch. Patrons can request and reserve items %ﬂ;ﬁ ) |format|0n fO Learn to Use Your Chromebook >
to pick up via curbside service or inside via self-checkout or (Mange) I Lox . .
HOWTO counter service. Distanced computers will be available for rson Pa Fis h LI

RENEW ITEMS: use by advanced reservation and distanced seating will be *Zoom - Let's learn to use it! >

available inside for patrons use. Parish Library is open to tk

ranch. Patrons can reques
curbside service or inside
e. Distanced computers v

‘ed reservation and distan [y Ancestry Library Edition Tutorial -- Access Billions
le for patrons use 1t ¥ ; >
2o of Genealogical Records

1. Online thru
Online thru = Meeting and study rooms will be open, but are subject to
your account AR e
the capacity limitations established by the State of Louisiana
2. Call TeleCirc at & Jefferson Parish. Patrons must wear a face covering or
5 mask (which covers both the nose and mouth) and undergo
(504) 885-8588 a temperature screening prior to entering.

Advanced Internet Search Techniques >

L.
+ Single and larger study rooms will be available with limited itudy rooms will be open,
capacity and time management. mitations established by t AtOZ World Food >
- . ol
* A reservation for a meeting room is required. There will be rish. Patrons must wear a
a limited capacity for each individual meeting room due to :overs both the noseand r g

ial distancing. Click here fi ti ities. 5 st i - i
| soca distancing. Click here for meeting room capaciti y o » y screening prior to enterif . Auto Repair Source - Automotive Information >
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ADDITIONAL RESOURCES

Additional helpful resources can be accessed through our homepage www.jplibrary.net

* From the library’s homepage, click on the JPL Digital * Then click on the LinkedIn Learning icon to access
Content link or the Digital Content menu tab. online training using your library card number and pin.
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tablet, or mobile device using the -3 Basks Online

Text-a-Librarian free Zinio Reader app!

| 2t emal_sninders Click here for more information.
Search the collection II' n
of the American
Italian Research Through our website, patrons now have unlimited multi-user access to
I_ibraD[ complete digital magazines, which can easily be viewed on most
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NOTES

Jefferson Parish Library authorizes you to view and download materials such as this handout at our web site (www.jplibrary.net) only for your personal, non-commercial
use, provided that you retain all copyright and other proprietary notices contained in the original materials on all copies of the materials. You may not modify the
materials at this site in any way or reproduce, publicly display, perform, distribute or otherwise use them for any public or commercial purpose. The materials at this site
are copyrighted and any unauthorized use of any materials at this site may violate copyright, trademark, and other laws. If you breach any of these Terms, your
authorization to use any materials available at this site automatically terminates and you must immediately destroy any such downloaded or printed materials.
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